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Proprietary Rights of Business Technology, Inc. (BTi) applications include the 

following: 

The Attendant Solutions suite of products and related data and information are 

proprietary and confidential to BTi and are the subject of trade secrets and 

copyrights licensed from BTi. The programs and related data and information are 

provided in confidence. All use, disclosure, copying, transfer or storage of these 

items, except as authorized in the written License Agreement from BTi to the user, is 

strictly prohibited. Information in this document is subject to change without notice 

and does not represent a commitment on the part of BTi. 

COPYRIGHTS: 

© 2018 Business Technology, Inc. (BTi).  All Rights Reserved. 

301 Mallory Station Rd., Suite 200, Franklin, TN 37067; United States of America. 

TRADEMARKS: 

BTi and the Attendant Solutions and individual application logos are registered 

trademarks in the United States of America. 

All other brand or product names mentioned may be trademarks of their respective 

companies or organizations. 
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Preface 

Welcome to the School Closings Attendant™ 7.2 User Guide. This guide describes 

the features of the School Closings Attendant™ application. 

Intended Audience 

This guide has been written for System Administrators, News Directors, Lead News 

Producers, News Producers, and Master Control Operators to help in learning the 

functionality available in School Closings Attendant.  

BTi Technical Support 

Technical support is available to answer questions and to help with any problems 

encountered using the Attendant Solutions suite of products. BTi Technical Support 

may be contacted in the following ways: 

Method of Contact Information 

Website www.bti.tv 

Email support@bti.tv  

Voice U.S. 615 591 1900 x1 

We Value Your Input 

We are interested in hearing your comments about this book, particularly if it fell 

short of your needs or expectations.  Please send your comments to support@bti.tv  

 

http://www.bti.tv/
mailto:support@bti.tv
mailto:support@bti.tv
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1      
Introduction 

School Closings Attendant fully automates the capture and delivery of school, 

business and other public-related closings information.  

Closings can be entered manually, via web site entry, or automatically captured via 

telephone call-in and/or electronically from a centralized reporting service's wire 

feed or web server. A single call or web entry can execute closing conditions for 

multiple entities/schools, include user-defined status codes, and allow a voice mail 

message or a text message with additional 'closing' message to be delivered to the 

station.  

Email, pager, phone notifications, outbound text messaging and automatic CG start 

up can be automatically and simultaneously executed immediately when closings 

begin arriving. 

About This Book 

BTi developed this user guide to describe the features of the School Closings 

Attendant. It consists of the following sections: 

 

Section Description 

2 – Accessing School Closings 

Attendant 

Describes how to start Attendant 

Solutions and access the School 

Closings Attendant 

3 – Configuring School Closings 

Attendant 

Describes the SC Options screen, which 

enables the user to customize how the 

School Closings Attendant works for 

your facility 

4 – Maintaining School Records Describes how to add new school 

information, edit existing school 

information, create associations, and 

record and/or review the school name 

voice message using the Maintenance 

screen 
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Section Description 

5 – Reviewing School Closings 

Information 

Describes how to review non-standard 

or additional information voice 

messages left by schools and how to 

manually update closing information 

using the Review screen 

6 – Viewing Current Closings Describes how to view the current 

closing status of any school which has 

called into the system using the Inquiry 

screen 

7 – Transmitting Closings Describes how to send active closings to 

air, to web or any other output using 

the Transmission Status screen 

8 – Viewing Reports Describes how to view and print School 

Closings Attendant generated reports 

using the Reports screen 
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2 
Accessing School Closings Attendant™ 

This section describes how to start Attendant Solutions and access the School 

Closings Attendant 

To access the School Closings Attendant:  

1. Double click the Attendant Solutions icon found on the computer desktop 

to open the Login screen. 

2. Enter the assigned User ID and password and then click [Login]. Contact 

your system administrator if you do not have an assigned User ID or 

password. 

 

 The Main Menu screen displays. 

 

 

Note: The applications displayed on the right of the screen will vary depending 

upon which applications the facility purchased. 

 

3. Click the [School Closings] button to open the application.  
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• The menu bar changes to show School Closings in the drop down list 

and displays buttons associated with the School Closings Attendant 

application. If the system contains a Dialogic card, the phone lines are 

displayed. 

• Phone lines will only appear on the workstation on which the 

telephony is set up. A selected phone line may be turned on or off by 

double clicking the line box in the upper left hand corner of the Main 

Menu.  

 

 

To review messages, a message port must be selected and the phone line 

which is used to review messages must be plugged into the appropriate jack on 

the back of the Attendant Solutions computer. 

*Caution: A faulty configuration of the system’s phone lines hinders or impairs 

the performance of the Attendant Solutions system. If any problems are 

encountered or there are specific questions, contact your local administrator. 

 

Databridge is an optional data service which is being offered by BTi.  

For more information on BTi DataBridgeTM , please contact Carolyn Williams, 

Product Manager at 615-591-1900, ext 701.  

 

phone lines 
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3 
Configuring School Closings Attendant™ 

This section describes the SC Options screen which enables the user to customize 

how the School Closings Attendant works.  

To access the SC Options screen, choose File > SC Options from the Main Menu. 
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The SC Options screen displays with the 'Reset' tab open. 

 
 

'Reset' tab 

The 'Reset' tab is used to manually reset school closing status information and 

messages or set up a schedule as to when a reset will occur automatically. 

Automatic Reset 

Events may be automatically purged (reset) in one of two ways: 

1. "Reset past events at {the number of specified minutes} past the hour" 

purges the status information (Closed, Open Late, and Closing Early) at the 

specified minutes after the next whole hour defined in the Reset Event 

Times section below. This setting allows the system to reset events multiple 

times during the day. 

2. "Reset past events each day at {a specific time}" purges the status 

information for all of the schools once a day. 

Note that if an event enters the system after the purge time, the event will be 

retained until the next day. 

Voice messages may also be reset (deleted) automatically at the same time the 

events are reset. This can be done in two ways:  

1. "Automatically delete played messages" will purge the voice messages 

which have been played at the same time the events are purged.  
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2. "Delete messages after {a defined number of days}" will reset played 

messages automatically after the specified number of days. (Unplayed 

messages will still be retained until played.) 

Click [Apply] to save changes. 

 

Reset Event Times 

Specify the times at which Closed items, Open Late items, and Closing Early items 

should no longer go to air and be eligible for reset. Then click [Apply]. These times 

will automatically be entered in the "Keep Status Until" field in the Review - Details 

screen for the individual school and can be edited individually in that screen. (See 

Chapter 5, "Manually Editing Closings".)  

Reset Now 

Data can be reset immediately by choosing either “Reset past school events” or 

“Reset all school events” and clicking the [Reset Now] button. 

Messages 

The user may immediately delete all messages which have been played, all 

messages regardless of whether they have been played or the message line entry. 

The last option clears the phone line if it is not responding properly. 

Choose the appropriate option and click the [Delete] button. 

'Notify' tab 

The 'Notify' tab is used to edit and prioritize notifications triggered on the system. 
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To prioritize notifications, click an individual notification and then click the [Up] or 

[Down] button to move the notification to the desired level. The top item in the list 

is executed first. 

To edit notifications, select the notification to be edited and then click [Edit]. 

 

 

 

The information on the Notify tab changes to Edit mode. 
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• Click the Inactive cell on a specific notification to allow the notification to 

fire off an alert upon detection of activity after a period of inactivity. A 

check mark symbol displays. Click the cell again to turn off the check mark.  

 

• Click the Message cell on a specific notification to allow the notification to 

fire when a new phone message is received or a typed message has been 

received through web entry. A check mark symbol displays. Click the cell 

again to turn off the check mark. Note: Either the Message cell or Inactive 

cell can be checked, but not both. 

 

• An Interval prevents the system from firing off alerts every few seconds as 

multiple closings are received. For an Inactive notification, a 90 to 120 

minute interval is common. A much shorter interval (even one to five 

minutes) is more common for a Message notification, since those messages 

must be approved before they can go to air or to the website. Click the 

Interval cell on a specific notification to enter the number of minutes to 

wait between receiving alerts before a notification fires. 

 

• A Delay gives the user time to process messages without being alerted 

continually. Click the Delay cell on a specific notification to enter the 

number of minutes to wait before firing the alert. 

 

• A Minimum number of closings may be specified before the alert is aired. 

Use this option to show several closings in the display rather than just one. 

The default is to notify on one closing. 

 

Click [Save] to save any changes and exit the Edit mode. 
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'Review' tab 

The 'Review' tab is used to modify Custom Messages appearing in the Review 

screen of the Main Menu. Modifications include: width of the note box (in twips), 

maximum characters in status lines #1 and #2, and the increment used when 

automatically assigning ID numbers.  

 

 

 

Click [Apply] to save changes. 

 

"Show Effective Update Time"  - When checked, this option shows an additional 

update field which can be edited on a school's detail screen. (See Review - Details 

screen, Chapter 5.) 

"Give Option to Ignore Changes" - This option allows the user to ignore a change in 

the closing status shown on a school's detail screen, thereby avoiding too many text 

messages sent out to listeners. (See Chapter 5, "Manually Editing Closings".) 

 

Hold for Approval with Web Entry 

This section gives options for station personnel to approve any text entered by 

school personnel via web entry before going on air. 
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'Recordings' tab 

The 'Recordings' tab allows the user to quickly record a batch of school names 

instead of recording school names individually using the Maintenance screen. These 

recordings identify the school and confirm to the caller that they are entering 

information for the correct school. 

 

 

 

To record school names: 

1. Select the school for which a name will be recorded from the School Name 

Recordings list. 

2. Click [Record]. 

• If recording on a telephone, pick up the phone and make the 

recording. 

• If recording on a microphone, speak directly into the microphone. 

3. Click [Stop] to end the recording. 

4. Click [Play] to hear the recording. 

5. Click [Refresh] to reload the school names recordings list. 

6. Click [Print] to print the school names recordings list. 
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'Entities' tab 

The 'Entities' tab is used to add, edit, and delete entity (school) types.  

 

 

 

 

To add new school types: 

1. Click [New].  

     The information on the Entities tab changes to Add mode. 

 

 

2. Enter the type code.  

3. Enter a description of the school type. 

4. Click [Save]. 
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To edit a school type: 

1. Select the school type to be edited. 

2. Click [Edit].  

3. Make desired changes and click [Save]. 

To delete a school type: 

1. Select the school type to be deleted. 

2. Click [Delete]. 

3. When asked to confirm, click [Yes]. 

 

"Auto assign ID #'s..."  - This option will automatically assign ID numbers to newly 

created records in the Maintenance screen. 

"Auto assign password..."  - This option will automatically assign passwords to newly 

created records in the Maintenance screen.  

See Chapter 4, "Adding Records" for further explanation. 

 

'Caller' tab 

The 'Caller' tab is used to define primary and secondary call-in menus including 

special status messages, additional caller options, and time of day options. 
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Primary Call-in Menu 

• "Use Traditional Status Menu" -  This option allows the use of the original 

‘Line 1’ status messages of Closed, Opening Late, Closing Early and Open. 

• "Use Special Status Codes" – This option allows the use of Primary Status 

Messages (defined in the Sp. Status menu) that the user has defined rather 

than the traditional status messages defined above.  

Secondary Call-in Menu 

• "Use Bus Secondary Menu" – This option includes bus options such as 

Running Late, Snow Routes, and Not Running during a call-in session. 

• "Use Special Status Codes" – This option makes the special status codes 

options menu (defined in the Sp. Status menu) available to a caller. An 

administrator can create new special status messages as well as edit and 

delete these messages.   

• "Exclude Secondary Menu" – This option will not offer a secondary menu to 

the caller. 

Additional Caller Options 

• "Add leading zeros to IDs" – This option forces School Closings 

Attendant to add leading zeros to the ID entered during a call session. 

For instance, a caller could enter 47 instead of 00047 for a 5 digit ID. 

• "Exclude Reset option" – This option will not allow callers to “Reset All 

Status Information” when calling in.  

• "Prevent Voice Messages" - When checked, this option will not allow callers 

to leave a voice message by default. This setting may be overridden by 

editing the settings in the school's individual maintenance window. 

• "Do not require password on call-ins" - Checking this option will allow 

callers to access their school's status immediately after entering their ID 

number. 

Time of Day Options 

• "Use Time of Day for Late Openings" – This option allows callers to enter 

the time of day that the school will open late instead of the number of 

minutes. 

• "Use Time of Day for Early Closings" – This option allows callers to enter the 

time of day that the school will close early instead of the number of 

minutes. 
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'Special Status' tab 

The 'Sp. Status' tab is used for viewing and maintaining the Special Status Messages 

available during a call-in session. 

 

 

 

The Message grid is used to create, edit, and delete user defined status messages.   

• Primary status messages appear in the Status column of the Review screen 

(accessed from the Main menu) and on the first line of the "On-Air Text" 

display in the Review - Details screen for the individual entity. (See Chapter 

5.) 

• Secondary status messages also appear in the Status column of the Review 

screen and on the second line of the "On-Air Text" display in the Review - 

Details screen. These are most often used in addition to a standard Primary 

status. If no Primary status has been entered, the Secondary status will 

move to the first line of the "On-Air Text" display. 

Associated Traditional Status - Use these options when creating a new Primary 

status that would replace a traditional status. 

"Keep Status Until" – This is the time of day that the status message will reset. After 

reset, the school with this message will no longer appear on-air. 

[Record] and [Play] buttons - (These are disabled on a workstation if that 

workstation does not have a soundcard.) If the system is using telephony, special 

status messages must be recorded in order for callers to choose the proper 
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message. (If a status message is not recorded, the caller will not hear that option.) 

The steps are as follows: 

1. Select the name of the message to be recorded from the messages list. 

(Note that any message that does not have a recording will indicate "No 

recording" on the lower right when selected.) 

2. Click [Record]. 

• If recording on a telephone, pick up the phone and complete the 

message.  

• If recording on a microphone, speak directly into the microphone. 

3. Click [Stop] to end the recording. 

4. Click [Play] to hear the recording. 

 

'Parameters' tab 

The 'Parameters' tab is used for maintenance and addition of school reference 

fields.  The individual per-school references are entered in the Maintain Schools 

menu. These references may be used to tag each school with some additional piece 

of information that is unique to your facility's on-air display. 
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'Database' tab 

The 'Database' tab displays workstation information and current SQL information 

contained on the database. This information includes data such as the number of 

schools, contacts, school status, and status histories. 
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4 
Maintaining School Records 

This section describes how to use the Maintenance screen to: 

 Add new school information 

 Edit existing school information 

 Create associations  

 Record / review the school name voice message  

 

To access the Maintenance screen, start from the Main Menu and click [Maintain] or 

select Edit > Maintain Schools. 
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The Maintenance screen displays, showing the school with the first ID number. 

 

 

• To use the School Closings Attendant, a unique school Identification 

number (ID) must be associated with each school entered in the system. It 

can be up to six (6) numeric characters. 

Note: If no school IDs have been specified for any schools, they can be 

generated by BTi when your particular system database is loaded during 

installation. Thereafter, the user is required to assign a unique ID number for 

each new entry entered into the database. Optionally, IDs may also be 

automatically assigned. This is the recommended method, since it prevents 

possible duplications. 

• A password may be designated as an additional level of security. See the 

next section on adding records for further details. 

• A type or category of school must be defined and specified in any manner 

preferred.  Some examples: Public school, College, City school, Vocational 

school, or more precisely specifying Public Elementary School or Private 

College.   

Types or categories can also be grouped. An example of grouping would 

be to specify an area (contained within a larger region), such as a county 

(CO) within a state. These school specifications are later incorporated into 

the sequencing specifications for transmitting school closing information.  

• A voice recording of the school’s name may be recorded and reviewed. 

This recording will be heard when the school's representative calls in. (See 

'Recordings' tab.) 
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Adding Records 

To add a new record, click the [New] button on the Maintenance screen. 

 

 

 

 The Maintain Entities – New screen displays. 
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• "Entity ID" - The user may assign an Entity (school) ID number, or click the 

[Auto Assign ID] button in the upper right-hand corner. The [Auto Assign 

ID] button automatically assigns a School ID with the next available ID 

number. Once assigned, this number cannot be changed or edited. 

• "Password" - A password may be designated as an additional level of 

security.  If the user chooses to designate a password, it must be alpha 

and/or numeric with a maximum of six (6) characters. (This password will be 

entered via telephone or computer keypad.)  

 Note:  A password must be designated if the school is accessed over the Web.  

• "Entity Name"- Enter an entity (school) name. 

• "Entity Type" - Choose a type from the drop down list. See Chapter 3, 

“Configuring School Closings Attendant” for more information on adding 

new entity types and editing entities using the Entities tab. 

• "On Air Name 1" - Enter the name to be displayed on air. (This may or may 

not be the same as the school name.) 

• "On Air Name 2" - Optionally, enter any additional description or 

information to be displayed on air.   

• Optionally, enter a school address including "Street", "City / State / Zip", 

telephone number ("Tel#"), and "County". While not required, entering an 

address here will make it easy to run a mail merge for letters to be sent. 

• Optionally, enter a "Sequence Number" if the school is to be sequenced 

differently than alphabetically within its respective sort groups on air. 

• Choose a "Time Zone" for the location of the school. This should default to 

the local "Time Zone". Please contact BTi if this is not the case.  

• Entering a "Group" name allows schools to be sequenced in a user-defined 

order. 

• "Match Code" - used when information is coming from an outside source. 

• Enter "Additional Comments" as necessary. 

• Check the “Prevent Voice Messages” box to disallow any incoming voice 

messages. If this box is checked and someone calls to report a status, 

leaving a voice message is not an option.  

• Check the “Exclude from Transmission” box to prevent the school’s status 

from being seen on the air or on the station's website. (Useful for testing.)  

• Check the "Special Handling" box if this on-air display is written to use as a 

flag for some special display on air. 

• Check the ”Active" box to activate the school. Inactive schools cannot be 

updated and are not included in the transmission. A red message will 

appear in the middle section of the screen which reads “Inactive”. 

• Click [Save] to add the school record to the database. 



School Closings Attendant User Guide 7.2 

Business Technology, Inc. Rev. Aug, 2015 22  

• The user should also add contact information to the new school as 

described in the “Adding Contacts” section later in this chapter. 

• After creating a record for a new school and recording a voice message, 

the new school is ready to use the system. 

Sorting Records 

School records may be sorted by ID or by name.  

• To sort records by ID, click the “Sort by ID” option and then use the [Prev] 

and [Next] buttons to view the records in numeric order. 

• To sort records by name, click the “Sort by Name” option and then use the 

[Prev] and [Next] buttons to view the records in alphabetical order. 

 

Searching Records 

The Find function gives the user the ability to access and change school information 

quickly.  Use Find to search for a school record by school ID, Name, or by Advanced 

Query. 

To search records, click the [Find] button.  
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The Find screen displays. 

 

   

To search by ID:  

1. Select the “ID” option and enter the school's ID number.  

2. Click [Query] or press the <Enter> key to display the search records. 

To search by Name:  

1. Select “Name” and define the search string by choosing the “Beginning 

With”, “Containing”, or “Ending With” option.  

2. Enter the search string in the Name field and click [Query] or press the 

<Enter> key to display the search records. 

To search by Advanced Query:  

1. Click the “Advanced Query” check box and choose a school type from the 

list box. Or, click the “Select All” check box to highlight all school types 

shown in the list box.  

2. Click [Query] or press the <Enter> key to display the search records. 

3. The search may be further refined by entering the city, state, zip, county, 

group, and/or area code. Click [Query] or press the <Enter> key to display 

the search records. 

To search by Advanced Query again, click [Clear Query] and redefine the search. 

To select a record, double click the record or click the record to highlight it and 

then click [Select] or press <Enter>. 
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Editing Records 

One of the most important functions of the Maintenance screen is the ability to 

change and edit school information to keep the school records up-to-date.  

To edit school records, select the school to be updated by using [Find] or the [Prev] 

and [Next] buttons. 

• When using the [Prev] / Next] buttons: Locate the record and then click the 

[Edit] button to display the Maintain Entity – Edit screen. 

• When using the [Find] button: Search by ID, Name or Advanced Query. 

When the desired record is found, click the [Select] button to go back to 

the Maintenance screen. From the Maintenance screen, click the [Edit] 

button. 

 

The Maintain Entity - Edit screen displays.  

 

 

Make any desired changes and then click the [Save] button to update the database 

with the new information.  

Deleting Records 

To delete school records, select the record to be deleted using [Find] or using the 

[Next] and [Prev] buttons. 



School Closings Attendant User Guide 7.2 

Business Technology, Inc. Rev. Aug, 2015 25  

• When using the [Prev] / [Next] buttons: Locate the record and then click 

the [Delete] button. Confirm by clicking [Yes] to remove the record from 

the database. 

• When using the [Find] button: Search by ID, Name or Advanced Query. 

When the desired record is found, click the [Select] button to go back to 

the Maintenance screen. From the Maintenance screen, click the [Delete] 

button. Confirm by clicking [Yes] to remove the record from the database. 

References 

The [References] button accesses the Special References screen. 

 

 

 

If school parameters were defined in the SC Options Parameter tab to utilize with 

the on-air display, it will be necessary to enter the individual school's parameters in 

the Value column. 

The values entered are defined by the user. 

 

 

Adding Contacts 

To add contact information to a school record: 

1. Using [Find] or the [Prev] and [Next] buttons, select the school record to 

which contact information will be added. 
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• When using the [Prev] / [Next] buttons, locate the record and then click 

the [New] button under Contact Information. 

• When using the [Find] button, search for the record by ID, Name or 

Advanced Query. When the desired record is found, click the [New] 

button under Contact Information. 

 

 

 

The Maintain Contacts screen displays. 

 

 

 

2. Enter the contact name, job title, home and work phones, email address, 

and any additional notes possibly needed to describe the contact. 

3. Indicate whether this contact is a primary contact by clicking the “Primary 

Contact” check box. 
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4. Click [Save] or press the <Enter> key. 

 

Editing Contacts 

To edit contact information, select the school which contains the contact 

information to update using the [Find] button or the [Prev] / [Next] buttons. 

Click the [Edit] button under Contact Information. 

 

The Maintain Contacts screen displays in Edit mode. 

 

 
 

Make any changes and click [Save] or press <Enter> to update the database. 

 

Deleting Contacts 

To delete contact information, use the [Find] button or the [Prev] / [Next] buttons 

and select the school containing the contact information to be deleted. 

Click the [Delete] button under Contact Information. When asked to confirm, click 

[Yes]. 

*Caution: Removing a contact from school records also deletes the referral to a 

school’s closing information. 

 

 

Creating Associations 

If desired, multiple schools (entities) may be associated to one school record. 

Associations allow grouping of school records so that when a closing occurs, only 

one entry is required to update all associated records. 
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To associate multiple schools to a single school record, use the [Find] or the [Prev] / 

[Next] buttons and select the school record with which multiple schools will be 

associated. 

Click the [Associations] button. 

 

 

 

The Associated Entities screen displays. 

 

 

Choose the entities to be associated, then click the [>>] button to move the entities 

to the association list box. More than one entity at a time may be chosen by 

holding the <Ctrl> key while clicking the desired entity. The entity list can be sorted 

by clicking the following column headers: ID, Name, County, City, or State.  

Click [Save]. 
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Note: Entities which appear in red indicate an association to the current record. 

Also, the [Associations] button on the Maintenance screen will change to show 

the number of associations for that entity.   

 

Recording / Reviewing a School Name 

While names can be recorded individually using the steps below, it is quicker to 

record a number of schools at one time using the SC Options screen.   

See Chapter 3, 'Recordings' tab, for more information. 

To record a school name individually: 

1. From the Maintenance screen, select a school for which to record a name; 

click the [Record] button.  

 

 

 

• If recording on a telephone, pick up the phone and follow the voice 

instructions to record a new name. 

• If recording on a microphone, speak directly into the microphone. 

2. When the name has been recorded, click [Stop] to end the recording.  

3. Click the [Play] button to review the recording or click the [Record] button 

to make another recording. 
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5 

Reviewing School Closings Information 

The Review screen is used to review standard, non-standard or additional school 

closing information and to manually update closing information. This will keep the 

school’s closing information data stream for transmission correct and current. 

To access the Review screen, click [Review] or select Edit > Review Closings on the 

Main Menu. 
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The Review screen displays. 

 

 

If no closings have been entered, all schools in the database are displayed 

alphabetically, as in the example above. If a particular school is not on the screen, 

use the scroll bar to search for the record. If closings have been reported, only the 

currently closed schools will show here. 

A visual alert automatically displays in the "V" column  and in the Voice Messages 

section when a new voice message has been recorded; this provides an easy way to 

locate the school record and listen to the voice message(s).   

These voice messages may be played and the closing information data stream 

record for that school may be manually updated. 

When closings are present, the View Closings section at the lower left may be used 

to filter the display to a specific status type.  

Reviewing New Voice Messages 

To replay and listen to a school’s voice message, the system used must be 

equipped with a telephone handset and suitable hardware or a soundcard.   

If a school has called into the system and left an additional voice message, the [New 

Msg] button will immediately become enabled and is highlighted in red. This button 

remains enabled as long as there is a message from a school which has not been 

played. 

Note: The [New Msg] button is also highlighted in red on the Main Menu. 
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To review new voice messages: 

1. Click the [New Msg] button on the Review screen or the Main Menu to 

display the message. 

The Review - Details screen displays. 

 
 

The "On-Air Text" shows the touch-tone closing information entered by the 

caller. The entity / school who left the message is also shown.  

2. The system will connect to the telephone handset or the soundcard. 
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3. If using a phone, when the phone rings, answer by handset or 

speakerphone and wait for the new voice message to play. If using a 

soundcard, the message will play through the speakers. 

4. If necessary, repeat the voice message by clicking the [Play] button. 

5. After listening to the voice message, determine if the closing information 

for that school needs to be modified. If so, craft a succinct text message 

string that redefines the closing condition and/or adds to the information 

contained in the voice message. 

6. The phone may then be kept off the hook and the [Prev] / [Next] buttons 

used to select the next or previous school with a new message in the 

database. Click [Play] to play the voice message. 

7. Hang up the handset or speakerphone when done.  

Manually Editing Closings 

School closing information may be manually edited if, for instance, a school left a 

voice message which changes the current closing information.  Otherwise, the 

system will automatically update the closing information.  

To edit closings: 

1. From the Review screen, click [Find] to locate the school for which to edit 

closings or scroll down the list.   

Schools can be sorted by clicking on a column heading to make locating a 

school easier. 

2. Double click on a school in the list.  

 

The Review – Details screen displays for that school. 

 

Note: This screen may have a different appearance and show different options, 

depending upon the options chosen on the SC Options > 'Review' tab and SC 

Options > 'Caller' tab. 
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3. Make any desired changes. 

• To specify that a school will be closed, click the “Closed” check box. 

The "On-Air Text" is displayed. 

• To specify that a school will be opening late, click the “Opening Late” 

check box. Click the up or down arrows to indicate how late the school 

will open in number of minutes or a specific time. The "On-Air Text" is 

displayed. 

• To specify that a school will be closing early, click the “Closing Early” 

check box. Click the up or down arrows to indicate how early the 

school will close in number of minutes or a specific time. The "On-Air 

Text" is displayed. 

• To specify that a school will be open after closing, click the “Open After 

Closing” check box. The "On-Air Text" displays that the school, which 

had been closed earlier in the day, is now open. 

• The "Other" check box is automatically checked when a Primary special 

status code is chosen from the drop-down box.  

• A special status code may be chosen as secondary on-air text. For 

example, school bus schedule information, evening events information, 

extended care information, or night class information. (Note that a blue 

text above the drop down box will indicate whether a special status 

code is Primary or Secondary.) The secondary On-Air Text is displayed. 

• "Keep Status Until" - If necessary, change the date and time that the 

status information will expire (no longer go to air). 

• The "Ignore Change for Text Broadcasts" check box may be used when 

testing or when making a change for which a text broadcast would not 

be necessary. 

• Click the “Hold for Approval” check box to hold the updated closing 

information for approval. This is generally used to hold automated 

closings from going on-air. It can also be used if a caller's credentials 

cannot be immediately verified. 

4. Click [Save] or press <Enter> and answer the prompt. 

Resetting Closing Information 

Use the [Reset] button on the Review - Details screen to remove all closing 

information for a specific school. Reset would be used if all the closing information 

for a particular school is to be taken off air or the school details have expired. 
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6 
Viewing Current Closings 

Using the Inquiry screen, users can view the current closing status of any school 

which has entered information via telephony or website. Users can also display 

additional information about the schools listed, including a school’s address and 

contact information. 

To access the Inquiry screen, click [Inquire] or select List > List of Closings from the 

Main Menu,  
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The Inquiry screen displays. 

 

 

 

The Inquiry screen displays the school ID, school name, closing status of the school, 

an indication of whether the closing is excluded from transmit, time and day the 

closing was updated, and the entity (school) type.  

Reset 

The [Reset] button enables the user to quickly reset all closing information 

manually. If closing information has expired, the data can be reset by selecting a 

school or group of schools (using Shift-click) and clicking the [Reset] button. The 

user will be prompted to confirm. See Chapter  3, “Configuring School Closings 

Attendant", 'Reset' tab for more information on resetting school closing status 

information and messages. 

Refresh 

Closing information may be automatically refreshed by clicking the “Auto Refresh” 

check box. The information will be refreshed every 30 seconds. Closing information 

may also be manually refreshed  immediately by clicking the [Refresh] button. 

Print 

Print the current school closing information contained on the Inquiry screen by 

clicking the [Print] button. 

Note: The [Print] and [Reset] buttons are not necessarily on all workstations.  

These buttons and their functionality are enabled or disabled by the system 

administrator in the Maintain Users program. When enabled, the [Print] button 

allows the user to print a report which lists all closing information for the day. 

This is the same report titled "Activity Log - Current by Name" provided in the 

Reports program accessed from the Main Screen. Unlike that program, however, 

the [Print] button on the Inquiry screen does not offer any printing options. 
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Viewing Additional School Details 

 

To view additional school information, double click the school to be displayed.   

The Entity Status Inquiry screen displays.  

 

 

 

Click [Close] to return to the Inquiry screen. 



School Closings Attendant User Guide 7.2 

Business Technology, Inc. Rev. Aug, 2015 38  

7 
Transmitting Closings 

School closings are transmitted by accessing the Transmission Status screen, which 

is used to: 

 Start, pause, and stop transmissions  

 View the status of transmissions  

 Create new transmissions based on existing transmissions 

 Edit and delete existing transmissions 

To access the Transmission Status screen, start from the Main Menu and click 

[Transmit] or select File > Transmit Closings. 
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The Transmission Status screen displays. 

 

 

 

Note: In this text and on the screen, the terms "transmission" and "job" are 

synonymous and can be used interchangeably.  

Devices List 

The list at the top left of the screen shows the video graphics devices which are 

currently active; it defaults to show All Devices.  Select a specific device to limit the 

jobs shown in the jobs list to ones using that device.  

By clicking the [A] at the upper left of the list and then right-clicking the device, 

users may give an alias to a particular device, which may make it easier for staff to 

identify the device.  

If a status of Ready is indicated, the device is ready to use. If any other status is 

indicated, check the Transmission Supervisor for the device by going to the 

Datacast Status screen (File > Datacast Status on the Main Menu). If the 

Transmission Supervisor is not running, it will have to be started on the device to 

which it is assigned. 

 

Applications List 

All BTi applications installed on the system are shown here. The list defaults to All 

Applications, but selecting one application will display only the transmissions for 

that application. 

 

In the example below, "School Closings" was chosen in the Applications list, which 

limits the job list to show only those jobs which pertain to School Closings. 
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At the right of the Applications list are three additional buttons: 

[Show Active Jobs Only] - Limits the display to active jobs. 

[Show Spots with Data Connectors] - This button is disabled unless Transmission 

Generator tm has been purchased. For more information, visit  http://www.bti.tv or 

send an email to sales@bti.tv. 

[Show Hidden (*) Jobs] - Individual transmissions can be configured to be hidden. 

When this is done, they will not appear to the casual viewer but can be shown by 

clicking this button. This ability is normally restricted to administrators and can be 

made more secure by setting up a profile whose members aren't allowed to select 

that button. Transmissions which need to run all the time are most often those that 

are hidden.  

Groups List 

Transmissions can be sorted into groups. This is useful if there is a group of jobs to 

run at a certain time. For example, AM News Group could be set up with only those 

transmissions which are used during the morning news. Groups may also be used 

to limit access to certain jobs. These groups can be managed with the [New], [Edit], 

and [Delete] buttons. 

Jobs List 

The Jobs list box shows information about all the  jobs which are currently available, 

their job ID, the devices associated with them, and their status. 

There are four columns which describe each job: 

Job ID A unique number generated by the application which 

represents a specific transmission or job that has been saved 

http://www.bti.tv/
mailto:sales@bti.tv
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Job Name Name of the transmission job as created or edited by the 

user. The job name usually indicates or describes the type of 

transmission job. For example, “PM School Closings”. 

Device The graphic device which will generate the output for the 

job. A job can only use one device.  

Status Indicates status of the transmission, either Active, Paused, or 

idle. A job's status will show as n/a (not available) if its 

associated device is not running. 

 

With the appropriate user permissions, these jobs can be edited and copied. Jobs 

which have been previously duplicated from an original can also be deleted if the 

user has permissions, but original jobs cannot be deleted.  

Associated with each job in the list are buttons labeled:  

  [Configure],  [Content],   [Start], and   [Take] 

 

 
 

[Configure] - This button will display the Configure Job screen for that job. 

Shown below is the screen for Job SC53 

 

 

• On the top two lines, the job is named and assigned to the correct device.  

• Jobs can be given a priority so that if a transmission is running and one 

with a higher priority is fired, the first one will stop to give way for the 

second. 99 is the highest priority and is sometimes used for those jobs that 

send out the most severe weather warning. See the note on priorities later 

in this chapter for further explanation. 
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• The job can be hidden from display all the time or hidden when active by 

checking the appropriate boxes.   

• "Lock Job Details" can be checked to keep others from making edits.  

• End Job group box -- Jobs can be scheduled to stop running at a specific 

time or for a set number of cycles. They can also be linked to other jobs, 

causing the second one to start when the first one ends. 

• Jobs can be copied or deleted. For example, if a job needs to go to another 

device or to run at another time, the original job can be copied and then 

edited to meet those needs. See "Creating a Job" below for further 

explanation.  

 

[Content] - This button will display the Maintain Transmissions screen for that job. 

Note that a job's screen may have a different appearance, depending upon which 

application type is chosen.  

 

 

 

Shown below is the Maintain Transmissions screen from a job in the School 

Closings application. 
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• The job name, device assignment, priority, and ending parameters cannot 

be edited in this screen. Those items can only be edited in the Configure 

Job screen.  

 See the section below on editing a job for instructions. 

• Selection Criteria group box -  

 

Entity Types: Only selected entity types will go out in the transmission. Click 

on the entity type to select it. Click on it again to de-select it. In this 

example, only schools and child care facilities would go out to air. If other 

entity types were needed to go out, they would also need to be selected. If 

the transmission is started and there are no schools available in the 

selected type(s), the transmission will immediately stop.  

 

** This is one of the main calls made to BTi support. If a transmission is started 

and stops immediately, always check to see that the correct Entity Types are 

selected and closings are available in that Type. **  

 

• Status - Only a selected status will go to air. More than one status may be 

selected. If no status is selected, the transmission will not go to air. 

• Groups may also be set up in this section. For example, a specific group or 

even a specific state can be chosen to go out in the transmission. Entities 

are assigned to groups on their respective maintenance page. 

• Transmission Sequence group box  - The order in which items will go to air 

is set up here. Available items lists the sorting options. Moving the option 

over to the Sort by list determines the manner in which they go to air. The 

items are executed in order, top to bottom. In this example, schools would 

first be sorted by entity type and then alphabetically by name. 

• [Customize] - This button will display the Advanced Transmission 

Parameters screen.   
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These Parameters will vary, depending upon the transmission.  

After making changes, click [Close] and the changes will be saved. 

 

** This is another call often made to BTi support. If a transmission is not getting to 

the correct destination, it is important to check the transmission parameters to see 

if the ftp site address, user name, or password has been changed. ** 

 

 

 

 

[Start] and [Take] buttons - 

 

 

 

Clicking either of these buttons causes the transmission job to carry out the 

function, whether it is running locally or on a remote PC or server. 
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Start the transmission by clicking the [Start] button for that job.  

The job status will then show "Active", the [Start] button will change to a [Stop] 

button, and the [Take] button will change to a [Pause] button. 

If the [Pause] button is clicked, the status will change to "Paused" and the [Pause] 

button will change to a [Resume] button. 

When a job is paused, it will go off air until it is resumed. When it is resumed, it will 

start where it left off instead of going back to the beginning.  

 

Job Status  

When a job is started, a Job Status window will be displayed which contains the 

current transmission activity and information for the specific job.   

 

 

The Status window displays the following transmission information: 

Job Name Name of the job, displayed in red 

Started at: Transmission start time and date 

Cycle# The number of times the data has been passed 

through 

#Processed: Number of records processed for the current 

cycle and the total number of records 

End of Cycle: The estimated time to the end of the cycle  

Last Update: The last time the information in the transmission 

was changed 

 

• Click [Pause] to suspend an active transmission job; select the “Now” option 

to pause immediately or “At End” to suspend the job at the end of the 

cycle. 

• Click [Resume] to restart the job if it is paused. 
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• To stop the transmission, click [Stop Now]. 

The Status window can also be minimized if desired. 

The job may have been initiated on the local system, but more than likely it is 

running on a remote PC or server. The Job Status window is initiated on the PC or 

server which is executing the transmission job process and it shows its activity and 

status on that machine.  

The job also communicates back to the initiating workstation - as well as any other 

workstations that are showing the Transmission Status window - that it has been 

activated and what its current status is.  

Creating a Job  

A new transmission job cannot be created from scratch; it can only be created by 

copying an existing job and modifying it to suit the needs of the user.  

To create a new transmission job based on an existing job, select an existing 

transmission job that is the same type (manual, automatic, crawl, web page, etc.) as 

what the new job should be. 

Click the [Configure] button for that job.  

 

 

 

 

The Configure Job screen displays.  
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Click [Copy Job]. When asked to confirm, click [Yes]. 

A new Configure Job screen will appear. A new job ID and name will be 

automatically generated. Enter a different job name if desired. 

Transmission jobs must be assigned to a specific device which will output the 

transmission. Choose an appropriate device from the "Assigned to Device" drop 

down list. 

Enter the time to stop this transmission or the number of cycles this job will run. If 

both fields are left blank or set to zero, the transmission will run continually until it 

is manually stopped. 

If desired, link to another transmission job so that when one transmission job ends, 

another begins. 

Enter a priority value between 1 and 99, where 1 is the lowest priority and 99 is the 

highest priority. This value is used to prioritize jobs. If the priority value is blank or 

set to zero, the job is not included in processing of priorities. 

 

A note about priorities:  

When a job with a priority is started, it executes in the same manner as before, 

but it also registers itself to the system. It is not until a second job with a priority 

starts that any changes are apparent. 

For example, if the priority of Job 1 is higher, Job 2 recognizes that it should not 

be running and terminates itself. If both jobs have the same priority, Job 2 

terminates. If Job 2's priority is higher, then Job 2 instructs Job 1 to terminate and 

Job 2 continues. When Job 2 is complete, it has the option to restart the job it 

terminated, namely Job 1. This will happen if the Job 2 "Restart" checkbox is set. 

School Closings Attendant  is capable of handling multiple job streams of 

priorities, as the case would be if the system is driving two character generators 

simultaneously. Jobs with priorities for one CG, should not affect a job with a 

priority on another CG. By default, the name of the CG is used to control job 

streams, but other options are available if needed. 
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Once the new job has been created and edited, [Save] and [Close] the Configure 

Jobs screen. The job will now appear in the jobs list in the Transmission Status 

screen.  

Editing a Job 

To further edit the job just created, or to edit any other transmission job, click the 

[Content] button for that job.  

 

 

The Maintain Transmissions screen will display. See the previous section on the 

[Content] button for more details about this screen. 

 

 

 

Make criteria selections by choosing the entity types going to air and status of the 

entities going to air. Optionally, the job may be further filtered by entering the 

group, county, state, and/or city. 

In the Transmission Sequence group box, items can be sorted by the "Available 

items" listed to the right. To add items to the sort list, select the item and click 
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[<<Add]. To remove an item from the sort list, select the item and click 

[Remove>>]. 

Some transmissions have customizable fields that can be accessed by clicking the 

[Customize] button.  

 

 

The Advanced Transmission Parameters screen will display. 

 

 

 

Changes to any parameters will be saved when [Close] is clicked. 

After making changes on the Maintain Transmission screen, click [Save Job] to save 

the newly created or edited transmission job.  

Click [Close] to return to the Transmission Status screen. 

The newly created transmission job will display in the Available Jobs list, along with 

its unique ID. 

Deleting a Job 

To delete a transmission job, use the Transmission Status screen to select the 

available transmission job to be deleted. 

Click the [Configure] button for that job. The Configure Job screen will display. 

Click [Delete Job] and confirm the deletion. 

Note: Only jobs which were created from an existing job can be deleted. 
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8 

Viewing Reports 

Reports generated by School Closings Attendant may be viewed and printed 

using the Reports screen.  

To access the Reports screen: 

From the Main Menu, click [Reports] or select List > Reports. 
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The Reports screen displays. 

 

 

 

School Closings Attendant offers three standard print formats from which to 

choose: 

• View a report in a window 

• Print a paper (hard) copy of the report 

• Save the report to a file 

Types of Reports 

The following table describes reports that are generated by the School Closings 

Attendant. 

Report Description 

List of Schools by Name Complete listing of each school and the school’s 

address sorted alphabetically by school name 

List of Schools by ID Complete listing of each school and the school’s 

address sorted by school ID 

List of Schools by Type Complete listing of each school and the school’s 

address sorted by school type 
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Report Description 

List of Schools by Group Complete listing of each school and the school’s 

address sorted by group 

List of Schools (New) Listing of new schools and the school’s address 

added to the system over a designated period of 

time.  

List of Schools – Mail-Merge 

Output 

This creates a delimited text file which may be 

used with a word processor document to 

produce letters or emails to school officials with 

instructions on how to use the system. The user 

is prompted for options. 

MMerge Mailing Labels 5160 

(1/School) 

Complete listing of each school and the school’s 

address in mailing label format (Avery 5160), 1 

per school. The user is prompted for school type 

and other options, such as sort order. 

MMerge Mailing Labels 5163 Complete listing of each school and the school’s 

address in shipping label  format (Avery 5163), 1 
per school. The user is prompted for school type 

and other options, such as sort order. 

Activity Log – Today’s Listing of the current day’s closing information 

Activity Log – Current by Type Listing of current closing information sorted by 

type 

Activity Log – Current by 

Name 

Listing of the current closing information sorted 

by name 

Activity Log – Historical Complete history of all closing information ever 

logged by the system.  The system prompts the 

user for starting and ending dates. 

School Associations Complete listing of each school and the school’s 

associations sorted by school. 

 

School Wallet Cards w/ Call-in Complete listing of each school, address, and 

school ID including a closings call-in number. 

Wallet size card format sorted alphabetically by 

school name.  
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Report Description 

School Wallet Cards w/o Call-

in 

Complete listing of each school, address, and 

school ID in wallet size card format sorted 

alphabetically by school name. 

 

 

Viewing Reports 

 

To view a report, select the report to view and click [Execute]. 

The report opens in a separate window, Report Viewer. 
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Printing Reports 

Reports may be printed in 2 ways: 

1. Click the Print icon in the report window. 

 

 

 

 The report will be sent to the default printer.  

2. Alternatively, right click the name of the report in the list and choose Print. 

This method allows a choice of printer, properties, etc.  

 

Saving Reports to a File 

Click the Export Report icon in the report window.  

 

 

 

Follow the prompts for required format and destination. 

 

 


